Blackboard Collaborate Software Instructions

How To Set Up Your Computer
How To Setup Your Mobile Device
# TABLE OF CONTENTS

## SETTING UP YOUR COMPUTER

- **Step One: Installing Java Web Start**

- **Step Two: Installing Blackboard Collaborate Launcher**
  - Installing the Launcher on Windows
  - Installing the Launcher on Mac

- **Step Three: Testing & Configuring Blackboard Collaborate**
  - Testing & Configuring Blackboard Collaborate on Windows
  - Testing & Configuring Blackboard Collaborate on Mac

## TROUBLESHOOTING

- Confirm the Launcher is Installed
- Create a File Association
- Clear the Launcher’s Java Cache
- Reinstall the Launcher

## HOW DO I CONTACT BLACKBOARD COLLABORATE TECHNICAL SUPPORT?

## MOBILE COLLABORATION – HOW TO SETUP YOUR DEVICE

## GETTING STARTED WITH BLACKBOARD COLLABORATE MOBILE WEB CONFERENCING QUICK REFERENCE GUIDE

- Understanding the Mobile Layout
- Understanding the Tablet Layout
- Joining a Mobile Web Conferencing Session
- The Participant List
- Audio
- Leaving a Mobile Web Conferencing Session
- General Information
SETTING UP YOUR COMPUTER

We recommend that you do this at your earliest convenience, preferably at least a few days before your first session. This may take a while on a dialup link, so please allow sufficient time before the first session.

Below are the steps that you will need to follow:

- Ensure that you are at the computer on which you will attend your live webinar session and that it is connected to the Internet.
- Ensure that you have a headset or microphone and speakers to take full advantage of the audio capabilities during the session.
- Ensure that you are an administrator on your computer and can install software. If you are unsure, please contact your system administrator.

**Step One: Installing Java Web Start**

To pre-configure a workstation or laptop, access http://www.blackboard.com/Platforms/Collaborate/Overview.aspx (this will bring you to Blackboard Collaborate website) and click on the ‘Support’ button (Figure.1), then follow ‘First Time User’ instructions (Figure.2).

![Blackboard Collaborate website](image-url)
Click on Blackboard Collaborate Web Conferencing (Figure. 3).
Check that your system is compatible with Web Conferencing.
Verify the system requirements by clicking on ‘system requirements for Blackboard Collaborate Web Conferencing’.

You will be directed to another page that will check if your workstation or laptop has the system requirements (Figure. 5).
STEP 2: Installing Blackboard Collaborate Launcher

Use the provided Configuration Room (Figure 6) to test your connection, settings, and configure your audio.

**V12.6 Configuration Room (AU-SAS)**

Web Conferencing - First Time Users

Date Published: Jul 03, 2014 Category: Product First Time Users; Version: Web Conferencing Article No.: 000037153

Product: Web Conferencing

Document Type: Administrator Documentation

Document Summary:

Document Details: This article contains the necessary information for anyone interested in using the Blackboard Collaborate Web Conferencing.

First time user with Blackboard Collaborate Web Conferencing

Get started by completing the steps outlined below:

STEP 1 - Check System Requirements

Make sure that your system is compatible with Web Conferencing. Please verify your system requirements:

system requirements for Blackboard Collaborate Web Conferencing.

STEP 2 - Configure your system

We provide a Configuration Room that you can use to test your connection, settings, and configure your audio. This is the V12.6 Configuration Room hosted on Blackboard Collaborate servers. To test your configuration for sessions hosted at your organization Administrator.

V12.6 Configuration Room (CA-SAS)
V12.6 Configuration Room (US-SAS)
V12.6 Configuration Room (EU-SAS)

V12.6 Configuration Room (AU-SAS)

Figure 6
Blackboard Collaborate will prompt you to download the Blackboard Collaborate Launcher installer

Click ‘download the Blackboard Collaborate launcher.’

Select your operating system (Windows or Mac) from the drop-down menu and click Download.

Installing the Launcher on Windows

Once the download has finished run the Blackboard Collaborate Setup Wizard. Different browsers will handle this differently and the behaviour of each browser may vary depending on how you configured your browser settings.

- **Firefox** prompts you to save the Windows installer BlackboardCollaborateLauncher-Win.msi. Save the file. The default save location is your browser's Downloads library. Open the Downloads library and, when the download is complete, open the file to run the Blackboard Collaborate setup wizard.
Chrome prompts you to save the Windows installer BlackboardCollaborateLauncher-Win.msi. Save the file. The default save location is your Downloads folder. In the bottom left corner of your browser window, Chrome shows you the progress of the download. When the download is complete, click on the downloaded file to run the Blackboard Collaborate Setup Wizard.

Internet Explorer prompts you to Run or Save the Windows installer BlackboardCollaborateLauncher-Win.msi. Click Run to run the Blackboard Collaborate Setup Wizard.

Click Next to run the setup wizard.

The setup wizard will install the Windows launcher and adds it to the Start menu. (Note: Windows 8 or later users can find the launcher on the Start page in Metro view.)

When you have completed running the Blackboard Collaborate Setup Wizard, return to the Downloading Installer page in your browser and click 'Join'.

**Downloading Installer**

When the installer is finished downloading, complete the following steps:

1. Run the installer.
2. Click Join to launch your session.

Need help with this?
Installing the Launcher on Mac

When the installer zip file BlackboardCollaborateLauncher-Mac.zip is fully downloaded, unzip the file to install the launcher.

- **Safari** automatically unzips the file and installs the launcher. No further action is required.
- In **Firefox and Chrome**, open the .zip file in your Downloads folder to unzip and install the launcher.

Your browser may ask you which application to use to open the .zip file. If so, select the Archive Utility (in System/Library/CoreServices).

By default, the launcher will reside in the Downloads folder. (When you open your session or recording .collab file, you are given the option to move the launcher to your Applications folder.)

Now that the launcher is installed, return to the Downloading Installer page in your browser and click the ‘Join’ button.

---

**Downloading Installer**

*When the installer is finished downloading, complete the following steps:*

1. Unzip the download.
2. Click Join to launch your session.

Join

---

**Need help with this?**
Step Three: Testing & Configuring Blackboard Collaborate

Testing & Configuring Blackboard Collaborate on Windows

After you click ‘Join’ on the Downloading Installer page your .collab file is downloaded. It is named one of the following, depending on the type of session: meeting.collab, course.collab or dropin.collab.

Open the .collab file:

- **Firefox** asks you what to do with the .collab file. Select Open with and then Blackboard Collaborate Launcher from the drop-down menu. (If there is no drop-down menu, click Choose and open your Downloads folder to select Blackboard Collaborate Launcher.)

  ![Firefox screenshot](image)

  You have chosen to open:
  
  meeting.collab

  which is: Blackboard Collaborate Session

  from: https://sas.elluminate.com

  What should Firefox do with this file?

  - Open with Blackboard Collaborate Launcher (default)
  - Save File
  - Do this automatically for files like this from now on.

  Settings can be changed using the Applications tab in Firefox’s Options.

  ![Firefox screenshot](image)

- **Internet Explorer** asks you what to do with the .collab file. Click Open or, if you want to reuse the file later, select Save and open.
- **Chrome** presents you with the file at the bottom of your browser window. Click on the file name.

(If you want future session files to open automatically, select *Always open files of this type* from the menu and then double-click the file name.)

Your session will now open and you will be logged in to the Configuration Session.

Please follow the directions displayed on the Whiteboard.

When the directions have been completed, choose ‘Exit’ from the File menu.
Testing & Configuring Blackboard Collaborate on Mac

After you click ‘Join’ on the Downloading Installer page your .collab file is downloaded. It is named one of the following, depending on the type of session: meeting.collab, course.collab or dropin.collab.

Open the .collab file:

- **Firefox** asks you what to do with the .collab file. Select Open with and then Blackboard Collaborate Launcher from the drop-down menu. (If there is no drop-down menu, click ‘Choose’ and open your Downloads folder to select Blackboard Collaborate Launcher.)

- With **Safari**, open your Downloads folder and then open the .collab file.

- **Chrome** presents you with the file at the bottom of your browser window. Click on the file name.

If you want future session files to open automatically, select ‘Always open files of this type’ from the menu and then double-click the file name.
You will be prompted to open the launcher.

![Launcher Prompt](image)

You are prompted to move the launcher to the Applications folder. This is not necessary but doing so will help keep your Downloads folder uncluttered.

![Move Prompt](image)

A Security Warning dialog asks if you want to run this application. Click ‘Run’.

![Security Warning](image)
Your session will now open and you will be logged in to the Configuration Session.

Please follow the directions displayed on the Whiteboard.

When the directions have been completed, choose ‘Exit’ from the File menu.

**TROUBLESHOOTING**

If you are unable to launch Blackboard Collaborate with your .collab file, typically, either your operating system does not know what application to use to open this file, you have not installed the launcher or there was a problem when you installed the launcher.

Read the topics below, in order, to troubleshoot your issue.

1. Confirm the Launcher is Installed
2. Create a File Association
3. Clear the Launcher’s Java Cache
4. Reinstall the Launcher

Note: For helpful articles and FAQs about the launcher, open our Collaborate Knowledge Base and search for "launcher".

1. Confirm the Launcher is Installed

As a first time user, when you open the session or recording link in your browser, you are prompted to download the launcher. The string `jwsdetect` in the URL indicates that the launcher detection process has not yet taken place.

When you click Join, Play or Launch Blackboard Collaborate now, you initiate the launcher detection process; that is, you are telling the software that you downloaded and installed the launcher. This sets a flag in your browser, which will bypass the Downloading Installer page next time you play a recording.

**Caution:** Do not click Join, Play or Launch Blackboard Collaborate now until after you have installed the launcher. If you do, the detection flag will be set inappropriately.

However, you may encounter the "first time user experience" (may be prompted to download the launcher) even though you installed it earlier.

You will be treated as a first time user when you open a session or recording link in the following situations:

- You cleared your cache and cookies last time you exited your browser.
- You use secure/private browsing.
- You installed the launcher using one browser but now are launching a session or recording in another browser.

If you see the string `launch` in the URL, it means you have already gone through the launcher detection process. Presuming you actually did install the launcher and have not since uninstalled it, seeing `launch` in the URL indicates that the launcher is installed.

**Caution:** When sharing a session or recording link with others, do not share links from the address bar of your web browser. Use the full (unprocessed) URL you used yourself – the one shared with you in an email or on a webpage. If you share the URL containing the string `launch`, others will not go through the launcher detection process and, if they don’t already have the launcher, will not be prompted to download it before obtaining the .collab file.

To confirm that the launcher is installed, look for the application on your system:

- **On Windows:** The Windows launcher is called Win32Launcher.exe. The default installation location is the following directory:
  
  C:%username%\AppData\Local\Programs\Blackboard\Blackboard Collaborate Launcher

  Alternatively, look for the application Blackboard Collaborate Launcher in the Control Panel, under Programs and Features, or in the Start menu.

  **Note:** Windows 8 or later users can also find the launcher on the Start page in Metro view.

- **On Mac:** The Mac launcher is called Blackboard Collaborate Launcher. The default installation location is your Downloads folder. However, when opening a .collab file, you were given the option to move it to your Applications folder instead, so check there too.
2. **Create a File Association**

Your computer may not know what application should be used to open .collab files. Normally, once the launcher is installed, the file association between it and .collab files is set automatically. However, if for some reason the association was not made, you can make it either through your operating system or, if a Firefox user, through your browser.

**Operating System**

For instructions on making the file association through your operating system, open our Collaborate Knowledge Base and search for "file associations".

**Link:** [http://blackboard.force.com/apex/publickbsearch?aType=Knowledge&viewAll=Collaborate](http://blackboard.force.com/apex/publickbsearch?aType=Knowledge&viewAll=Collaborate)

**Firefox**

**Windows**

Create the file association through your Firefox Options.

1. From the **Tools** menu, select **Options** and then the **Applications** tab.
2. For the Content Type **Blackboard Collaborate Session**, select the Action **Use other**..
3. In the Select Helper Application dialog, select **Blackboard Collaborate Launcher**.

![Firefox Options](image-url)
Mac

Create the file association through your Firefox Preferences.

1. From the Firefox menu, select Preferences and then the Applications tab.
2. For the Content Type collab file, select the Action Use other...
3. In the Select Helper Application dialog, select Blackboard Collaborate Launcher.

3. Clear the Launcher’s Java Cache

If the launcher is installed and the file association set correctly but you are still having problems launching your .collab file, try clearing the launcher’s Java cache.

1. Open the launcher application.
2. Open the Advanced tab and click Clear Cache.
4. **Reinstall the Launcher**

If you are still having issues, uninstall and reinstall the launcher.

a. **Uninstall Current Installation**

   Before you reinstall the launcher, uninstall the current instance of the installer as you would any other application:

   - On **Windows**, open Programs and Features in your Control Panel and uninstall Blackboard Collaborate Launcher.
   - On **Mac**, open your Downloads folder (or Applications folder if you put the launcher application there) and drag Blackboard Collaborate Launcher to your Trash.

   **Mac Note:** If you are having difficulty with the launcher installation process, see the Collaborate Knowledge Base article, Setting Mac OS X File Associations to open Blackboard Collaborate Launcher.zip files.

   **Link:** [http://blackboard.force.com/apex/publickbarticleview?id=kA770000000CbGS](http://blackboard.force.com/apex/publickbarticleview?id=kA770000000CbGS)

b. **Install the Launcher following the instructions previously provided in this document**

---

**HOW DO I CONTACT BLACKBOARD COLLABORATE TECHNICAL SUPPORT?**


(Available 24 Hours / Day - 7 Days / Week)

Blackboard Collaborate provides different methods in which to contact our Technical Support team, all of which you may find below. We've listed them in order of preference to ensure a timely and proper response.

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Create a case</strong></td>
<td>Provides an electronic form that allows you to enter key information about your question that allows the Technical Support team to provide an appropriate response. It also allows for immediate routing of your question to the appropriate team responsible for the category you select.</td>
</tr>
<tr>
<td><strong>Chat with an agent</strong></td>
<td>Provides the ability to chat with a Tier 1 Technical Support Representative for a response to your questions.</td>
</tr>
<tr>
<td><strong>Blackboard Collaborate Support Phone Numbers</strong></td>
<td>Occasionally you may wish to speak with a Client Support Representative on the phone. The Technical Support Team is available by different numbers worldwide, depending on your current location. These numbers are answered by a live agent 24x7x365. The numbers are as follows:</td>
</tr>
<tr>
<td><strong>International Toll Free Numbers:</strong></td>
<td></td>
</tr>
<tr>
<td>Australia: 1.800.26.7338</td>
<td>United Kingdom: 0800.051.7248</td>
</tr>
<tr>
<td>Ireland: 1.800.64.4528</td>
<td>All other International, non Toll Free Numbers: 1.606.274.2370</td>
</tr>
<tr>
<td>North America: 1.877.382.2293</td>
<td></td>
</tr>
</tbody>
</table>

For any other queries please contact your nearest EIT Office. Contact details are available on our website: [www.eit.edu.au](http://www.eit.edu.au)
MOBILE COLLABORATION – HOW TO SETUP YOUR DEVICE

Blackboard Collaborate Mobile Web Conferencing is designed for active learners who are on the go.

**Please note you can NOT view webinar recordings with your device**

**You can only attend the live webinar sessions using the App**

Session attendees can participate in live web conferencing sessions from the following devices:

<table>
<thead>
<tr>
<th>Mobile (iOS)</th>
<th>Mobile (Android)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apple iPad 2</td>
<td>Samsung Galaxy S3</td>
</tr>
<tr>
<td>Apple iPad 3</td>
<td>Samsung Galaxy S2</td>
</tr>
<tr>
<td>Apple iPad 4</td>
<td>Nexus 7 Tablet</td>
</tr>
<tr>
<td>Apple iPod Touch (4th Generation)</td>
<td>Galaxy Tab 10.1</td>
</tr>
<tr>
<td>Apple iPod Touch (5th Generation)</td>
<td>Nexus 10 Tablet</td>
</tr>
<tr>
<td>Apple iPhone 4</td>
<td>LG Optimus Black</td>
</tr>
<tr>
<td>Apple iPhone 4s</td>
<td>Kindle Fire</td>
</tr>
<tr>
<td>Apple iPhone 5</td>
<td></td>
</tr>
</tbody>
</table>

You can download the free app at the following app stores (dependant on your device)
Understanding the Mobile Layout

Room Options

Participants List

Talk

Answer Poll

Raise Your Hand

Content Area

Emoticons

Stepped Away

Chatbox

Trent Gillaspie:
We will get started here in just a second.

Donald:
Sure we can begin

4:16 PM

4:16 PM
Joining a Mobile Web Conferencing Session:

The first step in joining a Mobile web conferencing session is to visit the appropriate App Store and download the app.

Once the app is installed on your device, the application icon will appear.
To start the web conferencing session:

1. Tap the app to open.
2. You may receive a security message, similar to the one shown below. Please make sure you click ‘Accept’.

3. Copy the webinar room link from your Moodle course page and paste that link into the ‘Blackboard Collaborate Session URL’ area.
4. Enter your full name. **This information is very important as it is how the course coordinator will correctly identify you when marking attendance.**
The Participant List

On a tablet, the Participants List will be displayed by default and is only hidden when the Content area is expanded into full screen.
On the phone, the Participants List is hidden by default.

To open the Participants List:

- Tap the icon to open and close the list.

Understanding the List:

- Tammy has her hand raised.
- Stacy is using an emoticon.
- Bobby has stepped away from the session.

Audio

Participants on mobile devices can fully participate in the audio portion of the web conferencing session.

Audio Off

Audio On

Audio Permission Revoked by Moderator
Leaving a Mobile Web Conferencing Session

- To leave a session, tap the Room Options button
- Tap the Leave button

General Information

- If the mobile device is put to sleep or the web conferencing app is sent to the background, a red banner will appear on the screen to indicate that the session is still active.

- If the web conferencing app remains in the background or the device is put to sleep for more than five minutes with the talk button OFF, you will be automatically ejected from the session.

- If the talk button is ON when the device is put to sleep or sent to the background, the session is still active and the microphone is transmitting.

- Mobile participants cannot send Private chat messages.

- Mobile participants can zoom in on the Content area by putting two fingers together on the screen where they want to zoom in, and make a spreading motion across the glass. To zoom back out, they can pinch your fingers together.